
    

Version 02 Manual for Antibody Analysis and 
for Eplet Matching (June 2016) 

 

Introduction 

HLAMatchmaker is an algorithm based on HLA epitopes identified by molecular structural 
modeling and amino acid sequence comparisons between HLA alleles.  It considers each HLA 
allele as a series of small configurations of polymorphic residues referred to as eplets as 
essential components of HLA epitopes. The website-based International Registry of HLA 
Epitopes (http://www.epregistry.com.br) describes the repertoires of HLA-ABC, -DRDQDP and 
-MICA eplets. An important question is which eplets correspond to actual epitopes specifically 
recognized by HLA antibodies.  

Recent publications describe antibody-verified epitopes recorded so far in the HLA Epitope 
Registry.  All of them correspond to eplets and there are two patterns.  First, a specific antibody 
reacts with all alleles carrying a given eplet whereas the remaining alleles in the panel are non-
reactive. In these cases, an eplet describes the epitope specifically recognized by antibody. 
Second, an epitope is defined by the combination of an eplet and another polymorphic residue 
configuration (eplet) uniquely shared between all antibody-reactive alleles. Such epitopes are 
referred to as eplet pairs. The repertoires of antibody-verified epitopes must be considered 
incomplete and we are continuously updating the website with new information. 

All programs on the HLAMatchmaker website are in Microsoft Excel format.  Epitopes are 
annotated according to the system in the HLA Epitope Registry and there are two general 
groups (1) antibody-verified epitopes identified experimentally with informative HLA 
antibodies and (2) eplets that are theoretically predicted as potential epitopes but we do not 
know yet which ones become antibody-verified.  

Previous HLAMatchmaker programs on this website were called version 01.  Because recent 
studies have identified newly antibody-verified epitopes, the new antibody analysis versions 
02 have more antibody-verified epitopes.  They have also additional features aimed to analyze 
antibodies recognizing new epitopes.  

Three programs address the antibody analysis for HLA-ABC, HLA-DRDQDP and MICA epitopes 
and they are designed for reactivity with single allele panels. The Education section of the 
HLAMatchmaker website has a step-by step tutorial for antibody analysis.  

There are now also provisional HLA epitope maps for HLA-ABC, HLA-DR, HLA-DQ and HLA-DP 
with the locations of antibody-verified eplets and polymorphic residues as potential candidates 

http://www.epregistry.ufpi.br/


for epitopes.  These maps are helpful in navigating the continents of “HLA Epitopia” while 
searching for new epitopes. 

 

HLA-ABC antibody analysis (Version 02) 
With this new version you can now enter SAB results for up to 120 instead of 100 alleles. This 
program has multiple worksheets, but only two of them, “Panel” sheet and “Enter” sheet can 
be used for entering data: the SAB panel used for testing, MFI values and HLA types of patient 
and if possible the immunizer.  The program is based on epitope information shown on two 
password-protected sheets “Ep” for the antibody-verified eplets and “PrOth” for the antibody-
verified pairs and ‘other’ eplets.  Please notify us if there are inconsistencies in the epitope 
assignments.  Future versions will have updated epitope profiles. 

 

 “Panel” sheet 

This sheet has five columns (A-E) to describe the composition of the single allele kit used for 
testing. Copy the selected kit from the “OL kits” sheet (One Lambda, ThermoFischer) or the “LC 
kits” sheet (LifeCodes, Immucor) and paste it in columns A-E of the Panel sheet.  You may also 
add new kits on these sheets for kits. 

There are maximally 100 rows to enter the panel information. After entering the selected kit, 
the program generates for each allele a string of epitopes on columns F-KG.  All of them have 
functional formulas necessary for the program and they should not be touched.   

 

“Enter” sheet 

This sheet now displays the panel and its alleles. Columns L, M and N show for each allele the 
corresponding antibody-verified epitopes, the antibody-verified pairs and “other” eplets, 
respectively. They are listed sequentially with no breaks between their annotations.  

The first step is the entry of case information on row 1: patient id, serum data and test method 
used.  Then, enter the HLA-ABC types of antibody producer and if possible the immunizer.  The 
HLA types must be entered as alleles with 4-digit high-resolution types. They can only be 
selected from the allele lists used in this program. Any other allele entry will generate a 
message “wrong allele” and “try again”. Let us know if such allele is commonly found in your 
area and we will do our best to incorporate it in the program.  

In cases with only antigen or 2-digit type information, one can make estimates of 4-digit types 
from frequency tables in different populations in the “Freq” sheet.   

The program automatically determines which epitopes in columns L, M and N are mismatched 
for the patient. Note that the number of epitopes in each column is reduced.  

Entering alleles of the immunizer will generate information in Boxes J2:R7 about immunizer-
specific mismatched epitopes. The “All Eps” boxes show all of them and the “Reactive Eps” 
boxes show epitopes that remain after the program has removed the eplets on negatively 
reacting SAB alleles (see below).  Column H indicates which panel alleles belong to immunizer.  



Now enter the MFI values for the Luminex panel. This can be done manually but the easiest 
way is to copy the numbers from the csv files of the Luminex software programs (you may need 
some instructions from the manufacturer). You could select the trimmed mean values and if 
shown in horizontal rows you can copy these numbers and use the paste-special-transpose 
command (the shortcut click: alt E, S, E).   Enter the MFI values in column J starting on row 12 
and make sure that they line up properly with the bead numbers, the controls and the alleles 
of the panel.   

The newly copied MFI values may show up with multiple digits. To get nicely rounded values 
go to the Home tab to a “Font” command that leads you a “Number” tab a click on another 
“Number” tab so you can go to “Decimal places” and select “0”.  

The program automatically identifies the MFI values for self HLA-ABC alleles of the patient, 
they are shown in column G. It calculates an average self count and the standard deviation.  
Statistically, any value above the mean+3SD would be significantly higher than a negative 
reaction and this information can be used to establish the cut-off MFI value. 

Of course, you can enter in box J10 any cut-off MFI value.  For sera with wide reactivity ranges 
it seems worthwhile to try out different cut-off values to see what happens.   

After entering the cut-off value the program automatically identifies the negative alleles 
(column I now has “NEG” annotations) and removes all their epitopes from the panel and 
immunizer. Columns K, L and M show the remaining mismatched epitopes on the reactive 
alleles and boxes K2:K7 and N2:N7 show such epitopes on the immunizer alleles.  

The next step is to sort out eplets on the reactive alleles.  

 

“Sort Ep” sheet 

This protected sheet is intended to determine which epitopes are specifically present on the 
reactive alleles. It permits a distinction between “immunizer-specific” and “third-party” 
epitopes (epitopes on non-immunizer alleles that the antibody producer was exposed to 
during another sensitization event). DO NOT ENTER ANY DATA ON THIS SHEET.  

Columns K, L, and M show the mismatched immunizer epitopes (antibody-verified, antibody-
verified pairs and other eplets) on the panel alleles and columns N, O and P has the same 
information for third-party epitopes.  All data will be presented as third-party epitopes if the 
“Enter” sheet has no HLA typing information for the immunizer. 

Now sort the data.  Highlight rows 12-111 and under the Data tab click on the Sort Command 
which uses a certain consecutive order within the various columns. If this click leads to a signal 
“Protected Sheet” and you must first use the “Unprotect” command under the Review tab. 
Under the Review tab; no password is needed. Proceed to the “Custom Sort” command which 
includes multiple columns and press ‘OK’.  Afterwards, you may wish to protect the sheet again 
for safety reasons.  

In most cases, the sorted data show that the antibodies react with limited repertoires of 
epitopes and the program classifies them as immunizer-specific or third-party. You may wish 
to give preference to the antibody-verified epitopes. You may note that some epitopes are 
associated with high MFI values and others with low MFI values indicating weak reactivity.  It 



is also possible that certain reactive alleles lack any demonstrable epitopes. These issues will 
be discussed below but let us first look at possible clues about differently reacting alleles. 

 

“Comparisons” worksheet  

 

This sheet describes residue differences between Luminex alleles within same 2-digit groups.  
Certain antibodies may react with some but not with other alleles within a group and these 
residue differences provide clues about the structural basis of an epitope recognized by a given 
antibody.   

For instance, there are five A2 alleles on the list.  Certain antibodies have been shown to react 
with A*02:01, A*02:03 and A*02:06 but not with A*02:02 and A*02:05.   The reactive alleles 
share 43Q thereby suggesting that this residue play an important role in the epitope whereas 
the presence of 43R correlates with non-reactivity.  As another example, we have found 
antibodies that react with all A2 alleles except A*02:03 whereas others react only with 
A*02:03.  This allele has a distinct residue difference in position 149, namely 149T versus 149A.  
This position is important for the epitope recognized by these antibodies.  

As another example, A*24:02 and A*24:03 differ from each other in two positions which 
correspond to the 166DG and 166EW eplets. The antibody-verified 166DG is also on A*01:01, 
A*23:01, A*23:02, A*80:01 and B*15:12.   

The “Comparisons” worksheet is a useful tool to explain reactivity differences between alleles 
within certain groups.  It might identify residues that must play an important role in a given 
antibody-reactive epitope either as a part of mismatched eplet or as a self-configuration which 
serves as a critical contact site within the structural epitope.  

What to do with sera with uninterpretable reactivity patterns? 

We must first rule out certain problem factors such as “natural” antibodies, prozone effect and 
interference by other Ig-type antibodies, etc. Such sera need to be treated by various 
methodologies to remove such factors so that “clean” IgG-type HLA antibodies can be 
produced.   

Three scenarios are considered and each one can be best approached if HLA information about 
the immunizer is available.   

The first scenario reflects a rather common antibody reactivity pattern whereby some alleles 
carrying a specific eplet have high MFI values but others have much lower MFI values some of 
which might be even be close to the cut-off point.  It is possible that such antibodies react with 
epitopes defined by eplets but other yet unidentified nearby residue configurations affect 
reaction strengths.  How can they be identified?   

Columns T-DQ on the “Sort Ep” sheet are the places to look. They show for each allele the 
residues in all polymorphic and locus-specific sequence positions. The search can be best done 
with a separate Excel document. Under the File tab use the “New” command to get a blank 
Excel document. Use the Copy command for the entire “Sort” sheet and then under the” Home” 
tab of the new document, go to “Paste” and use the “Paste values” command. The short-cut is 
Alt-I-E-V.   



The new Excel document should only have values and no formulas. Each allele has its 
immunizer and third-party repertoires of eplets and select the eplet you want to analyze. For 
each allele, record this eplet in column J.   Then select rows 14-113 and under the Data tab use 
the “Sort” command to select column J (in ascending order) and a second column I (in 
descending order).  You will see all the eplet-carrying alleles with their MFI values in descending 
order.  Under the “Home” tab use the highlight command to mark the rows with the highly 
reactive alleles in yellow and the rows with the lowly reactive alleles in orange; intermediate 
MFI values might be without color.   

Next, scroll through columns T to DQ to determine which positions have residue differences 
between yellow and orange; there will not be many of them. These positions may play a role 
in the epitope defined by the eplet but they must be antibody-accessible. 

According to the structural epitope concept which considers all six CDRs of antibody make 
contact with an epitope, such residue positions must be within 15 Angstroms of the eplet.  Such 
positions can be determined on HLA molecular structures analyzed with the Cn3D program as 
described on the HLAMatchmaker website. This approach has been used to demonstrate how 
the reactivity of certain eplet-specific antibodies can be influenced by nearby residue 
differences within corresponding structural epitopes. It may also show the so-called 
Landsteiner type of serological cross-reactivity whereby certain residue substitutions within an 
eplet have no major effect on the reactivity with antibody. 

The second scenario is that certain reactive alleles have no identifiable immunizer-specific 
epitopes. Such alleles cannot have non-HLA epitopes recognized by so-called natural antibodies 
but they should have an epitope defined by an eplet paired with other residue configurations.  
However, we do not know which eplet is involved.   

This problem might be resolved by lowering the cut-off MFI value on the “Enter” sheet. This 
may lead to the appearance of additional eplets on these reactive alleles although other alleles 
with very low MFI values have the same eplet.  By practicing you can find out how low you 
must go!  Copy the resulting “Sort Ep” sheet on a new Excel document and as described above, 
follow the same directions to identify relevant residues which must be within 15 Angstroms of 
the eplet. 

The newly identified eplet pair must be shared by reactive informative alleles and the 
immunizing allele.  Most often, the critical configurations consist of self-residues present on 
the alleles of the antibody producer.  This approach has frequently been used to identify 
antibody-verified epitopes defined by eplet pairs and recorded in the HLA Epitope Registry. 

In the third scenario, the antibody reactivity pattern cannot be interpreted with the current 
version of HLAMatchmaker. The application of the so-called nonself-self paradigm of epitope 
immunogenicity can be useful in epitope specificity determination but this type of analysis is 
much more difficult.  

E-mail a copy of the “Sort Ep” sheet to Duquesnoyr@upmc.edu and Marrmx@upmc.edu if you 
want us to do an epitope analysis of a complex serum.  

 

“Acc Mm” sheet 

mailto:Duquesnoyr@upmc.edu
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The major purpose of serum HLA antibody analysis is the determination mismatch acceptability 
of HLA alleles at the epitope level.  

This protected sheet has the information about mismatched epitopes on class I alleles, 
including many that are not in single allele panels. Columns B-G list the immunizer-specific 
alleles whereas columns H-M list all epitopes shared with reactive alleles. Row 4 has a filter 
command that allows you to display only those alleles with certain numbers of mismatched 
epitopes. Click on the filter symbol for the desired epitope group(s) and select the number(s) 
of epitopes to be included in the resulting list. Depending on the determination of the cut-off 
MFI value and the interpretation of which epitope is clinically important, the program can 
readily determine which alleles are acceptable mismatches. 

 

Polymorphic residue sequences of ABC alleles 

The “Seq” worksheet shows for all ABC alleles the polymorphic residues shared between alleles 
in SAB panels.  They cover all sequence positions and the residue notations follow standard 
single letter codes. Several alleles have incomplete sequence data; in such cases positions with 
unknown residues are indicated by asterisks such as 207* and 253*.  

This sheet is useful in the identification of residues in newly identified epitopes as described 
above. 

 

 

  



HLA-DRDQDP antibody analysis (Version 02, May 2016) 
Version 02 includes many newly antibody-verified class II epitopes which have been 
experimentally documented with informative antibodies. They have been recorded in the 
International HLA Epitope Registry (www.epregistry.com.br ) together with the antibody 
reactivity data.  

This program has also additional worksheets with residue comparisons between related alleles 
and DRB, DQ and DP polymorphic residue sequences.  As discussed below, these sheets might 
be helpful in the analysis of difficult antibody reactivity patterns.  

IMPORTANT:  YOU CAN ONLY ENTER DATA ON THE PANEL AND ENTER SHEETS.  

 

“Panel” sheet 

Enter the four-digit types of the single allele panel of DRB1/3/4/5 and the DQA-DQB and DPA-
DPB heterodimers as well as other information about the kit.  A few lot-specific panels are 
shown on the One Lambda “OL” and LifeCodes “LC” sheets, and columns A-H can be copied to 
the Panel sheet. Additional commercial panels can be entered on the OL and LC sheets; use the 
same format as is shown.  

You can enter other panels but the upper limit for this analysis is 100 rows for each analysis.  
Each allele has a list of epitopes classified as antibody-verified eplets, antibody-verified pairs 
and other eplets.  They are listed on the “Ep”sheet (for DR and DQ) and “DPep” sheet (for DP).   

 

“Enter” sheet 

This sheet now shows the panel and its alleles. Separate columns describe the corresponding 
antibody-verified epitopes and other eplets. First, enter patient name, serum date and method 
used. Then, enter the HLA types of antibody producer and if possible the immunizer; the HLA 
types must be entered as alleles with 4-digit high-resolution types. They can only be selected 
from the allele lists used in this program. Any other allele entry will generate a message “wrong 
allele” and try again. Let us know if such allele is commonly found in your area and we will do 
our best to incorporate it in the program.  

Besides DRB1 alleles it is important to enter the DRB3/4/5 alleles. If this information is not 
available, you can go to the “DRB345DQBassoc” sheet to make your best estimate.  DQ allele 
typing information is important. If such data are not available, then go to the 
“DRB345DQBassoc” and “DQABassoc” sheets to come up with your best estimates.  These 
sheets reflect information about more common class II allele associations (they do not apply 
to DP) but you can never be certain that the DQ allele assignments are correct unless actual 
typing has been done. You can enter allelic typing data for one or all class II loci.  Enter ‘y’ as 
the second allele if only one allele has been identified for a locus. 

Boxes J2:S13 now show which donor epitopes (AbVerEp, AbVerPrs and Other Ep) are 
mismatched for the recipient.  The “All Eps” boxes show all of them and the “Reactive Eps” 
boxes will show epitopes that remain after the program has removed the eplets on negatively 
reacting SAB alleles (see below).   

http://www.epregistry.com.br/


Boxes P18: AB117 show for the DR, DQ and DP alleles in the SAB panel which epitopes 
(AbVerEp, AbVerPrs and Other Ep) are mismatched for the recipient.   

The next step is entering the MFI values in column N; this can be done manually but it is much 
easier to copy these numbers from the CSV files in the Luminex software programs of the SAB 
kits of the manufacturers.   Be sure that the MFI values line up properly with the controls and 
the alleles in the panel.  Under the Home tab, click in the Number box, then click on ‘Number’ 
in the list and set the decimal places to “0” to get nicely rounded MFI values.  

The program automatically identifies the MFI values for self DRB1/3/4/5, DQB and DQA alleles 
and it calculates an average self count and the standard deviation (boxes F14:I16).  Statistically, 
any value above the mean+3SD would be significantly above a negative reaction and this 
information can be used as a guide to establish the cut-off MFI value. The MFI value for self 
DRB is probably the best choice. Some DQ (and DP) heterodimers may give a high MFI if one 
chain is self but the other is nonself and recognized as a mismatch. 

Box N16 is set with the value of 0 (zero) but it is used enter the cut-off MFI value of your choice.   
The program automatically identifies as negative the alleles with MFI values below the cutoff 
value.  After clearing the epitopes from them, boxes P18: AB117 will show the mismatched 
epitopes that remain on the positive alleles.    

For sera with widely ranging reactivity patterns it seems worthwhile to try out different cut-off 
values to see what happens with the mismatched epitopes on the reactive alleles. You might 
see that some epitopes associate with strong reactivity but others with low MFI values. 

The next step is to sort out the different loci and determine which eplets are specific for the 
immunizer if typing information has been entered.  Three sheets distinguish immunizer-specific 
and third-party epitopes in three class II groups. 

 

“SortDR”, “SortDQ” and “SortDP” sheets 

These sheets show the reactivity of the entire panel but allow you to arrange the data according 
to locus and the presence of immunizer-specific and third-party epitopes on reactive alleles 
using preset sort commands.  DO NOT ENTER ANY DATA IN THESE SHEETS.  

 For example, on the “SortDR” sheet select rows 12:111. On the Home tab, go the Editing tab 
and select Sort & Filter, then Custom Sort, then “OK”.  You should readily see the epitopes 
shared between reactive alleles and how these epitope specificities correlate with MFI value.  
Column I shows the antibody-verified eplets and Column J shows the antibody-verified pairs 
shared by alleles of the immunizer. Column K shows the “other” eplets and you might see look 
for reactive alleles that uniquely carry them; such epitopes which might become candidates for 
antibody-verification.  

Other reactive alleles may lack immunizer-specific eplets and it possible that that the serum 
has antibodies induced during a different sensitization event. Columns L, M and N show the so-
called “third-party” epitopes that might be recognized.  

The “SortDQ” and “SortDP” sheets can be used for a similar analysis of the other class II 
reactivity patterns with the SAB panel.   The program considers the fact that both A and B 
chains of DQ and DP have epitopes and that certain epitopes can be defined by eplet pairs on 



both chains.  can be done on; select rows 12-111 and 10-109, respectively.  These data provide 
data about epitope specificities and this information permits the determination of mismatch 
acceptability of class II alleles as shown the following sheets.  

 

“Comparisons” worksheet  

This new sheet describes residue differences between Luminex alleles in the same 2-digit 
group.  Certain antibodies react with some but not with other alleles and these residue 
differences may provide clues about the structural basis of the epitopes recognized.  They must 
play an important role in the epitope either as a non-self eplet or a self-configuration as a 
critical contact site within the structural epitope. 

For instance, DRB1*01 has three alleles in most panels. A serum might react with DRB1*01:01 
and DRB1*01:03 but not with DRB1*01:02. The first two alleles have distinct 67L, 70Q and 71R 
residues and alternatively, the reactivity of only DRB1*01:01 and DRB1*01:03 can be explained 
with 85V and 86G.   

As another example, DQB1*02:01 and DQB1*02:02 differ from each other by only one residue 
135D versus 135G. Reactivity with only one of these two alleles can only be explained by the 
difference in position 135 which must play an important role in the epitope.  

The “Comparisons” worksheets have complete residue descriptions that distinguish two or 
more related alleles encoded by DRB, DQB and DQA.  

Please note for DQA that there are no differences for DQA1*03:02 versus DQA1*03:03 and for 
DQA1*05:01 versus DQA1*05:05 except in their leader sequences which are not recognized by 
antibodies. 

 

What to do if the antibody reactivity pattern is uninterpretable? 

It is possible that certain reactive alleles have just blank spaces, i.e. they lack any immunizer or 
third-party epitope listed on the epitope sheet.  Such alleles may have a technical problem or 
they may have non-HLA epitopes recognized by so-called natural antibodies.  Experience has 
shown that some alleles in certain SAB kits are more frequently involved.  

Another possibility is the serum has antibodies against one or more yet unrecognized HLA 
epitope(s) which cannot be detected with the current version of HLAMatchmaker. The analysis 
can only be done on a separate Excel document. 

This can be done as follows: under the File tab use the “New” command to get a blank Excel 
file. Use the Copy command for the entire “Sort” sheet and then under the ”Home” tab of the 
new file, go to  “Paste” and use the “Paste values” command . The short-cut is Alt-I-E-V.   

The new Excel file should only have values and two approaches can be used to identify a new 
epitope recognized by patient’s antibodies. The idea is to find informative alleles that are 
reactive but lack any immunizer-specific epitope recognized by other antibodies in patient’s 
serum. 

First, the epitope could be defined by a new eplet pair shared by informative reactive alleles 
and the immunizing allele.  To identify the eplet pair, one could enter a much lower MFI cut-



off value on the “Enter” sheet to see if another eplet (let us call it Eplet X) appears on the 
reactive alleles that were unexplained with the original cut-off value. Eplet X must be shared 
between the informative alleles and at least one immunizing allele but Eplet X may also be on 
other reactive alleles and even non-reactive alleles. The new “Sort” sheet should also be copied 
on another sheet of the new Excel file which now can be used for further analysis.  

In a new column enter Eplet X for each allele which has it. Highlight all rows with the SAB alleles 
and under the Home and Editing tabs use the “Sort & FIlter” command for the Eplet X column 
(in ascending order) and add the column with the MFI (in descending order).  

Relevant data have been selected and now the question must be raised which Eplet X-carrying 
alleles have distinct residues associated with reactivity or non-reactivity.  They can be 
identified with Columns P-BE.   

According to the structural epitope concept which considers that all six CDRs of antibody make 
contact with an epitope, the residue differences between Eplet X-carrying alleles must be in 
sequence positions within a radius of 15 Ångstroms.  Such positions can be determined on HLA 
structures analyzed with the Cn3D program as described in publications on the 
HLAMatchmaker website.  This exercise requires some practice. 

Another method to identify a new epitope is based on the so-called nonself-self paradigm of 
epitope immunogenicity.  This analysis can be done with the same Excel sheet used to identify 
pairs but it is much more difficult.  We suggest that you contact us about your case so we can 
help you out. 

  

“AcMmDR”, “AcMmDQ” and “AcMmDP” sheets 

These sheets show the epitope mismatch information on class II alleles including many that are 
not in single allele panels.  They can be used as guidelines to identify alleles with acceptable 
mismatches.  

Columns B-F list the immunizer-specific epitopes on reactive SAB alleles. They have been 
grouped as antibody-verified eplets and eplet pairs and the third group consists of “other” 
eplets that have not been identified as specifically antibody-reactive.  

Columns G-K list all epitopes, i.e. immunizer-specific and third-party epitopes. Again 
distinctions have been made between antibody-verified epitopes, eplet pairs and “other” 
eplets.  

Row 5 has a filter command which allows displays of alleles with certain numbers of 
mismatched epitopes.   

This program is a useful tool to determine mismatch acceptability at the epitope level but any 
clinical decision must include a careful analysis of patient’s sera tested in various assays and 
should assess reaction strengths of antibodies specific for detected epitopes and even if such 
epitopes would be clinically significant.     

 

 



Worksheets with DRB, DQ and DP polymorphic residue sequences 

Complete descriptions of HLA epitope repertoires are important for the clinical application of 
HLA epitope-based matching for transplantation. The antibody reactivity patterns of most class 
II reactive sera can be explained with the presence of antibody-verified epitopes shared 
between reactive alleles but other sera will have antibodies recognizing different epitopes.  
HLAMatchmaker has already lists of so-called other eplets which have not been verified yet. 
Certain sera may have a reactivity pattern that correlates with the presence of such eplet and 
might be used as experimental evidence for the antibody-verified status of the epitope. But we 
must also expect that other sera have a reactivity pattern that is too complex for 
HLAMatchmaker. In such cases, an analysis of polymorphic residue sequences might be useful.    

The “DRBres”, “DQres” and “DPres” worksheets show the polymorphic residues shared 
between alleles in SAB panels.  They cover all sequence positions and the residue notations 
follow standard single letter codes. Several alleles have incomplete sequence data; in such 
cases positions with unknown residues are indicated by asterisks such as 140* and 203*.  

 

 

HLAMatchmaker antibody analysis for MICA (Version 1.0) 

This Excel program applies the same features as used in the ABC and DRDQDP antibody analysis 
programs. First, it is based on the complete repertoire of MICA epitopes listed on the 
International HLA Epitope Registry website http://www.epregistry.com.br . Second, it 
distinguishes between antibody-verified epitopes including eplet pairs and other epitopes not 
(yet) defined by antibodies.  Third, after entering the cut-off MFI values it automatically 
identifies the reactive alleles and their mismatched epitopes.  Fourth, there is a separate sheet 
with a sort command that readily identifies immunizer-specific and third-party epitopes. Fifth, 
another sheet shows for the current repertoire MICA alleles which epitopes are mismatched, 
this information is useful in the determination of mismatch acceptability. 

Future versions will have updated MICA repertoires and newly antibody-verified epitopes will 
be added. 

  

http://www.epregistry.ufpi.br/


HLA Matching at the Eplet Level (Version 02, June 2016) 

Introduction 

The ABC and DRDQDP antibody analysis programs are designed to determine specific 
reactivities against single eplets or eplet pairs within the context of the structural epitope that 
makes contact with the six CDRs of antibody. Eplets are essential components of epitopes that 
elicit humoral immune responses but epitope specificities of antibodies can be variable 
depending on the immunizing allele with the mismatched eplet and the reactivity pattern of 
eplet-carrying alleles in the panel. Eplets represent small patches of amino acid residues and 
at least one residue is mismatched. Often enough different eplets in overlapping sequence 
positions have residue similarities.  This eplet design optimizes the epitope specificity analysis 
of HLA antibodies but it creates redundant information about eplet loads of HLA mismatches.     

The eplet matching programs use smaller repertoires of eplets selected on the basis that a 
given mismatched residue in an antibody-accessible molecular position has been used just 
once.  They can be used for a single donor-recipient combination or a meta-analysis of up to 
1000 combinations.  The data provide quantitative (eplet loads) and qualitative information 
about antibody-verified eplets and “other” eplets which have not been (yet?) verified with 
informative antibodies.   The version 02 update (June 2016) includes eplets (such as 79GT, 131S, 
138MI) which have been upgraded from “other” to antibody-verified status. 

HLA-ABC Eplet Matching 
This program has been designed to determine eplet loads of donor HLA alleles and to provide 
information which eplets are mismatched.  Eplet notations are based on those listed in the 
International HLA Epitope Registry (www.Epregistry.com.br).  This matching program 
distinguishes between eplets that correspond to antibody-verified epitopes and eplets that 
have not been experimentally verified with informative HLA antibodies. It will show the eplet 
numbers in both groups as well as the total eplet loads. 

The Registry has many overlapping eplets defined by residues in neighboring sequence 

positions in the 1 and 2 domains keeping in mind that some or many of them could define 
an epitope specifically recognized by antibody. But we must raise the question if all of them 
need to be included in determinations of eplet loads.  

Let us consider three residues in nearby polymorphic locations on the molecular surface of class 
I molecules: 62R, 65R and 66N. The Registry has nine eplets with annotations that include 62R, 
namely 62REN, 62RER, 62RN, 62RNQ, 62RNR, 62RR, 62RRN, 62RTN, and 63EI. There are eleven 
eplets with residue annotations that have 65R namely, 62GRN, 62RER, 62RNR, 62RR, 62RRN, 
63ER, 63ERN, 65RA, 65RK, 65RNA and 66RKQ.  There are fourteen 66N-annotated eplets: 
62GRN, 62REN, 62RN, 62RRN, 62RTN, 63EN, 63ERN, 63NN, 65RNA, 66N, 66NAH, 66NAQ, 66NM 
and 66NV. Altogether, twenty-three eplets have 62R, 65R and/or 66N in their annotations and 
four of them (62GRN, 62RNR, 62RR and 65RNA) correspond to epitopes that have been 
recorded as antibody-verified and it is possible others in this group might identify distinct 
epitopes experimentally identified with informative antibodies.   

However, this large collection of overlapping and structurally very similar eplets should not all 
be used in determining epitope loads.  One might postulate that mismatched residues in any 

http://www.epregistry.com.br/


of the well-exposed positions 62, 65 and 66 would be the driving forces that elicit antibodies 
to a variety of epitopes defined by these residues either alone or in combination with another 
nearby residue. From 44 eplets recorded in the Registry we have selected 19 eplets for the HLA-
ABC matching program, namely the antibody-verified 62RR, 65RA, 66N, 62EE, 62GE, 62LQ, 
62QE, 62GK, 65GK and 65QIA as well as 65GA, 65QA, 66IC, 66IF, 66IS, 66IY, 66K, 66KA and 66N 
listed as “other” eplets.   

The Registry lists 64 overlapping eplets with surface residues in polymorphic 1 domain 
positions 69, 70, 71, 73, 76, 79, 80, 82 and 83.  The ABC matching program considers 27 eplets: 
the antibody-verified 69AA, 69TNT, 70IAQ, 71SA, 76ANT, 76VS, 76ESI, 76ESN, 79GT, 80I, 76VRN, 
80TLR, 80K and 82LR as well as 69AT, 69RA, 69RT, 71QS, 71KA, 71HS, 73A, 73TV, 76VDT, 
76EN,76E, 76ED and 76EG. 

There are 30 overlapping eplets involving surface residues in 2 domain positions 138, 142, 
144, 145, 149, 150, 151 and 152. The ABC matching program considers 17 eplets: the antibody-
verified 138K, 144KR, 144TKH, 144QL, 150AAH, 149TAH and 151AHA as well as 138MI, 143S, 
145HT, 147L, 151HA, 152RE, 152RR, 152RV, 152RA and 152RT. 

This type of reductive analysis has been done for all sequence positions on the molecular 
surface; eplets defined solely by polymorphic residues in antibody-inaccessible positions have 
been excluded.   

Altogether, Version 02 of the HLA-ABC eplet matching program has a total of 132 eplets, 60 of 
them correspond to antibody-verified epitopes and there are 72 “other” eplets.  Future 
versions will have updated eplet repertoires that shift towards more eplets which have been 
experimentally verified with informative antibodies.    

How to use the HLA-ABC eplet matching program 

This very large program (39 MB) has been designed for up to 1000 donor-recipient 
combinations. It can also be used to compare one donor with multiple recipients to identify 
the best possible match or to test one recipient with multiple donors to determine which ones 
are most suitable in platelet transfusions.  

“EnterData” sheet      

Record all HLA types (inclusion of HLA-C is recommended) should be entered in high-resolution 
(four-digit) format and the program has a total of 564 HLA-ABC alleles; upon request more 
alleles can be added.  You can add other information about recipient (column A-C), donor 
(column J, K) and outcome such as allograft survival and antibody response (columns R, S).   

From the eplet repertoire shown on the password protected “Ep” sheet, the program 
automatically determines the eplet profiles for recipient and donor (the “Rec” and “Don” 
sheets are protected) and on the “EnterData” it identifies the mismatched eplets on each donor 
allele (data are hidden from view). 

“Results” sheet    

Columns A-S show all recorded information.  Columns T, U and V show the numbers of 
mismatched eplets, Total, Antibody-Verified and Other.  Columns W and X show details of 
mismatched eplets.  



Columns Z-IF show which eplets are mismatched in each case.  Please note that they are the 
result of calculations that include formulas in each cell. The “Results” sheet can be copied on a 
new Excel sheet (use the Paste Special command for Values) so you can do an analysis which 
eplets might be important for matching purposes.   

Example: analysis of a 10 donor-recipient combinations 

The table below shows the numbers of mismatched HLA-ABC eplets; you can readily see that 
the epitopes load decreases from case 1 to case 9.  Case 10 is an example for a combination 
that is HLA identical at the antigen level but at the allele level there are mismatched for both 
antibody-verified eplets and other eplets.  

 

The next table shows which antibody-verified eplets and other eplets that are mismatched for 
the recipient. 

  

  

Columns Z-IF show which eplets are mismatched in each case.  This is a sample for the antibody-
verified eplets for positions 1-90 

 

 

Some studies make only comparisons for HLA-A and HLA-B because no complete typing 
information is available for HLA-C.  The tables below demonstrate for the same 10 cases that 
the numbers and the repertoires of mismatched eplets are quite different from those for all 
three Class I loci. 



 

 

 

 

 

HLA-DRDQDP Eplet Matching (Version 02, June 2016)  

Introduction 

This program applies the same principles used in the HLA-ABC matching program. It has been 
designed to determine eplet loads of all donor class II HLA alleles and to provide information 
which eplets are mismatched.  Eplet notations are based on those listed in the International 
HLA Epitope Registry (www.Epregistry.com.br ).  This matching program distinguishes between 
eplets that correspond to antibody-verified epitopes and eplets that have not been 
experimentally verified with informative HLA antibodies. It will show the eplet numbers for 
DRB, DQ and DP in both groups as well as the total class II eplet loads. 

DRB eplet matching considers all DRB1/3/4/5 loci and Version 02 now includes 13FE, 47F, 67LQ, 
70D, 85VG, 96ES, 98EN and 104ART as antibody-verified eplets. The Registry has many 
overlapping eplets defined by residues in neighboring sequence positions on DRB molecules.  
They are included in the DRDQDP antibody analysis program because they optimize 
determinations of epitopes specifically recognized by antibody. But again we must raise the 
question which of them should be included in determinations of eplet loads.  

As an example, the DRDQDP antibody analysis program has 42 eplets in sequence positions 67, 
70, 71, 73, 74 and 77.  After removing redundant eplets with overlapping residues, the DRB 
matching program is left with 20 eplets namely the antibody-verified 67LQ, 70D, 70QT, 73A, 
74R, 77N and 77T as well as the “other” eplets 67F, 67I, 67L, 70Q, 70R, 71A, 71E, 71K, 71R, 73G, 
74A, 74E and 74L.   Altogether, the matching program uses 112 DRB eplets that can be identified 
on single allele beads including 39 that correspond to epitopes verified with informative 
antibodies.  

http://www.epregistry.com.br/


DQB1 has much fewer alleles than DRB1 and they have to somewhat lesser extent overlapping 
eplets defined by residues in nearby positions.  Interestingly, several groups of DQB1 alleles 
carry different non-overlapping eplets in separate locations on the molecular surface. The eplet 
notation system uses subscripts.  For instance, the antibody-verified 52PQ2 represents two 
eplet configurations in different non-overlapping sequence positions: 52P5355R56P and 
84E85V86G90I which are shared between DQB1*05 and DQB1*06 alleles in the single allele 
panel. An antibody reacting with this group of alleles recognizes specifically one epitope but 
with the current composition of the panel it is not possible to determine that this epitope is 
defined by 52P5355R56P or 84E85V86G90I or both.  Therefore, we refer to this epitope as 
52PQ2.   For eplet load determinations we must consider 52PQ2 as two eplets namely 52PQ and 
85VG.  Similarly, 52PL3 on DQB1*03 and DQB1*04 alleles in the single allele panel must be 
considered in eplet load determinations to consist of three eplets: 52PL, 140T and 182N.  
Altogether, Version 02 matching program has 74 DQB1 eplets including 32 that correspond to 
antibody-verified epitopes.  

Some DQA1 eplets have also subscripts.  For instance, the antibody-verified 40GR3 shared 
between the same group of DQA1*04, *05 and *06 alleles has three eplet configurations:  
40G41R45V, 47C48L and 50V51L52R52Q54F55R.  The current panel composition does not 
permit which configuration is recognized by a 40GR3-specific antibody.  For matching purposes, 
we must consider 40GR3 as constituting three eplets called 40GR, 47CL and 53QF. Altogether, 
the matching program has 43 DQA1 eplets including 11 that correspond to antibody-verified 
epitopes.   

The DP matching program has 8 antibody-verified and 27 “other” DPB eplets including and 19 
DPA eplets including 2 that have been antibody-verified.   

It should be noted that the antibody verification of class II eplets is a work in progress.  Certain 
eplets marked as “other” might be upgraded as antibody-verified if informative antibodies 
have been identified.   

 

How to use the HLA-DRDQDP eplet matching program 

This very large program (30 MB) has been designed for up to 1000 donor-recipient 
combinations. It can also be used to determine the eplet compatibility of one donor for 
multiple recipients or vice versa to seek in a donor file the best possible eplet match for a given 
recipient. 

“Examples” sheet has a few matching examples. 

“EnterData” sheet      

Enter recipient ID and other information in columns A-C.  All class II types must be entered as 
high-resolution (four-digit) alleles in the appropriate columns DRB1 and DRW (DRB3*, 4*, 5* 
or x) and DQB1 and DQA1 . If no such typing data are available you may wish to make estimates 
with the “DRB345-DQB assoc” and “DQBDQA assoc” sheets or look for suitable DR-DQ 
haplotypes in the National Marrow Bone Donor registry.  Entering DPB1 and DPA1 alleles 
always require actual typing data. 

Enter only DRDQDP alleles listed on password protected sheets “R”, “Q” and “P. 



 

Columns P and Q are for donor identification and you can enter donor class II alleles in columns 
R-AC.  Column AD can be used to record some outcome parameter such as graft survival or 
antibody response. 

The program automatically determines the eplet profiles for recipient and donor shown on the 
protected “Rec” and “Don” sheets.  Calculations in the “EnterData” sheet identify the 
mismatched eplets on each DR, DQ and DP donor allele (data are hidden from view).   

“Results” sheet   

Column AE shows the total numbers of DRDQDP eplets. Columns AF-AH are for DRB: Total 
(yellow), Antibody-Verified and Other.  Columns AI-AK are for DQ eplets in the same order.  
Since DQB and DQA are parts of the same molecule, the program has combined the numbers 
of DQB and DQA eplets.  Columns Al-AN show mismatched eplet numbers for DPB+DPA.  

Columns AO-AT provide summary information which “antibody-verified” eplets and “other” 
eplets are mismatches.  

Columns AV-PD show individual eplets that are mismatched in each case.  Please note that they 
are the result of calculations that include formulas in each cell. The “Results” sheet can be 
copied on a new Excel sheet (use the Paste Special command for Values) if you wish to do an 
analysis which eplets might be important for matching purposes.   

 

Example: DR-DQ eplet analysis for three recipients 

Class II matching has traditionally be done with serologically defined DR antigens.  However, 
every DR antigen has multiple closely linked alleles and we must consider that any DRB1 allele 
comes with a package of DRB3/4/5, DQB, DQA, DPB and DPA alleles and each of them has a 
distinct repertoire of eplets.  They lead to considerable differences in eplet loads. Depending 
on the recipient’s DRDQ type, some eplet loads are high and others are low.  

The “Examples” sheet has three DR-DQ-typed recipients exposed to a single serological DR 
mismatch (DR1, DR4, DR7, etc.) which was converted to a common DR-DQ haplotype.  

To try out the program, copy the HLA-typing information for Case #1 on the “Enter Data” sheet  

This table shows the results for the first case. By traditional matching criteria there is only one 
serological mismatch but there are considerable differences in the eplet loads. 

 

This table describes the details of the mismatched eplets 

 



 

 

 These tables show details of mismatched antibody-verified DRB and DQB eplets 

 

 

 

Please try out the other two scenarios in the “Examples” sheet. 

 

For questions and suggestions about this manual and the 
HLAMatchmaker programs, please contact Rene Duquesnoy at 
Duquesnoyr@upmc.edu 
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